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Chapter 1

Introduction

This manual describes Sense of Place, an interactive simulation program developed for use in
geography courses. Sense of Place was developed as part of Project GeoSim, a multidisciplinary
effort involving members of the Departments of Geography and Computer Science at Virginia
Tech to develop computer-aided instruction (CAI) modules for teaching introductory geography to
first year college students A Project GeoSim instruction module typically consists of two parts:
a multimedia tutorial of background information about the geography concepts involved in the
lesson, and a simulation program that allows students to apply, experiment with, and enhance the
knowledge they have gained.

The main goal of Sense of Place is to allow users to gain a sense of the characteristics of
U. S. counties by examining statistical data via a variety of simple data visualization techniques.
Currently, Sense of Place makes use of three visualization techniques: choroplethic mapping,
plotting statistical distributions, and tabular representation. However, Sense of Place is also
designed so that other techniques may be added in the future.

Each visualization technique is incorporated into a view. There are typically two views on screen
at a time. In short, a view comprises a particular visualization technique and the user interface
tools associated with it. The services these tools provide include easy ways of moving from one
view to another. For example, once a user finds the symbol for a division in one view, he or she
can click on it to find that division in the accompanying view.

The visualization tools in Sense of Place can be used to evaluate counties in terms of either
raw statistical data, or user-created metrics. A metric is a statistical standard composed of target
values for a set of statistics. Sense of Place determines a score for each county based on how close
its values are to the user’s targets. Metrics can be created for a variety of purposes. For example,
a user can create a metric that specifies the characteristics of his or her “dream” home or travel
destination, or a metric that identifies the important qualities of a successful business location.

We use the term “county” rather broadly to refer to counties, parishes, and burroughs, as well
as cities which are are politically independent of any county, since their data would otherwise go
uncounted. This is true, for example, of all cities in Virginia, as well as Washington, D.C.
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2 CHAPTER 1. INTRODUCTION

1.1 Characteristics of Geographical Data

Each visualization technique used in Sense of Place was chosen to show certain aspects of the
data associated with geographical divisions. Some of these aspects are inherently geographical. For
instance, geography is unique among disciplines in its concentration on the spatial characteristics
of data. Other aspects of geographical data are common to other disciplines. For example, the
distributions associated with variables are of interest to all fields of statistical study. It would be
difficult to present all of these aspects with one data representation technique. Therefore, we have
incorporated several visualization tools into Sense of Place: maps, distribution plots and tables.

Chapter 2 presents a tutorial introduction to the operation of Sense of Place. You are
encouraged to run through the program as you read it.



Chapter 2

Sense of Place Tutorial

2.1 Starting Sense of Place

To start Sense of Place on a DECstation, SPARCstation, or MS-DOS PC, type snsplace at the
command prompt, and hit the return key. To start Sense of Place on a Macintosh, open the
folder labeled exe in the snsplace folder, and double-click on the icon labeled snsplace. The screen
should appear as shown in Figure 2.1 when you start Sense of Place.

Figure 2.1 draws attention to several important screen areas. The various Sense of Place data
visualization techniques are presented in the top and bottom view slots. Context-sensitive hints

Message window

Bottom view slot

Top view slot

Menu buttons

Figure 2.1: Initial screen layout
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4 CHAPTER 2. SENSE OF PLACE TUTORIAL

about how to use Sense of Place are shown in the message window. The menu buttons are used
to access popup menus which are used to control the program.

When you start Sense of Place, the top view slot shows the Graph View, and the bottom
view slot shows the Map View. Note that there is no data shown in either view when the program
begins. Thus, there is only a pair of axes in the Graph View, and all states and counties are colored
gray in the Map View. Section 2.2 describes how you can select data for viewing.

2.2 Selecting Data

To select county data for viewing, press Data in the row of menu buttons at the top of the screen.
This button causes a popup menu to appear when pressed. This menu is shown in Figure 2.2.
Press Data now to access the menu. The items in the menu are listed alphabetically. Each item
tells Sense of Place to perform some service for you. The service that corresponds to each item
is described in the following list.

• Examine variable by county allows you to select a single variable. Once you select a select a
variable, Sense of Place shows you its values for every county.

• Find county on graph allows you to locate the datum for a county in the Graph View. This
item is not active when the program first starts, because there is no data shown in the Graph
View. The item is printed in gray to show that it is inactive.

• Find county on map allows you to locate a county on the county map in the Map View. This
item is active when the program starts, because counties can be shown on a map even when
it is not showing data.

• Rank counties allows you to select a set of variables for a ranking metric. A ranking metric
consists of a set of target values (one for each selected variable) used to evaluate counties.

Figure 2.2: Data menu
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Each county is given a metric score which reflects how close its statistical values are to the
target values.

• Show all statistics for a county allows you to select a single county. Once you select a county,
Sense of Place shows you a list of all statistical values in our database for that county.

To get a better idea of what the items in the county menu do, try using each of them. Each of
the following sections will walk you through the use of one of the items on the county menu.

2.2.1 Examine variable by county

When you select this item, the list window shown in Figure 2.3 will appear. The window contains
two list areas. On the left is the subject list area. This area will contain a list of statistical subjects
from which to choose. On the right is the variable list area. It is blank when the window first
appears. When you select a subject, the variable for that subject are listed in the variable list area.

Note that the subjects and variables you see on your screen may not be the same as the ones in
Figure 2.3, since the list of variables is dynamic. Since there are more items than can be shown at
one time in the limited screen space available, the lists are scrollable. The arrow buttons move the
list up or down one item at a time. Try pressing the down arrow button, and then the up arrow
button now to see how they work.

The arrow buttons will allow you to go to any item on the list, albeit rather slowly. If you want
to go faster, use the scroll bar. To use the scroll bar, place the mouse cursor over the gray scroll
button, hold the mouse button down, and drag the scroll button up or down as desired. Try this
now to see how it works.

Once you have found the item you want, place the mouse cursor over it and press the mouse
button once to select it. When you select an item, it is highlighted in the list and echoed in the

scroll button

up arrow button

subject selection field variable selection field

shift button

variable list area

down arrow button

subject list area

Figure 2.3: Statistic list
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selection field above the list. Try selecting a subject and then a variable now. You can change your
selection easily by clicking on another item. Select another variable. Note that the highlight moves
from the old selection to the new one, and the selection field is updated to show the new selection.
You can also change subjects if you don’t see a variable you like. Once you are satisfied with your
selection, press Done . You can press Cancel at any time to cancel the selection process and go back
to where you were.

When you press Done , the list window disappears, and Sense of Place retrieves the data for
the selected variable from its database. A splash window appears to show the progress of the data
retrieval. Once all the data have been retrieved, the splash window disappears, and the Graph
View and the Map View are filled in. Figure 2.4 shows the Graph View and the Map View for the
variable Persons reporting United States ancestry per 100,000.

Note that the Graph View now shows a plotted curve, a list of counties, and an indicator bar.
The indicator bar shows the graph position of the counties in the list. The list can be scrolled
just like the variable list. Alternatively, you can drag the indicator bar to any position on the
graph, and the list will automatically scroll to show the counties at that position. Try moving the
indicator bar, and note how the list changes. Note that the list also contains the precise value for
each county.

Also note that the maps in the Map View are colored according to the data. The color scheme
is shown at the bottom right of the state map (the one on the left). The brighter the color, the
higher the value for the county. The county map (on the right) shows the portion of the state map
that lies inside the box on the state map. This box can be moved with the mouse to any position.
Try moving it now — by holding the mouse button down and moving the mouse — and watch how
the county map changes. Note also that when the mouse cursor is over a state, that state’s name
is shown in the information bar above the maps.

Figure 2.4: Graph View and Map View for Persons reporting United States ancestry per 100,000
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The information bar also contains value and rank fields, which are used to show data values and
ranks for states and counties. “Value” is currently highlighted because the coloring of the maps has
been calculated according to the statistical values for all the counties. (The coloring can also be
calculated according to rank, as we will see in Section 2.4.1.) Try placing the mouse cursor over a
county in the county map. Notice that, in addition to the county’s name, its value for the variable
and its rank among all counties is shown in the information bar.

We will examine other aspects of the Graph View and the Map View later. Let’s go on and
look at the other items in the county menu.

2.2.2 Find county on graph

If you look back at the county menu, you will notice that this item now appears in black. This
means that you can select this item to find the position of a particular county on the graph. Go
ahead and select this item now.

You should see window with a list of state names on the left, and a blank list on the right.
The blank list will be used to show counties after you select a state. The state list works just like
the variable list: you can scroll it up and down, make a selection, and change your selection once
you’ve made it. Try selecting a state now. (The state you live in might be a good one to pick.)

When you select a state, the name of the state is highlighted, and echoed in the selection field
above the list. The counties in the selected state are then shown in the list on the right. The
selection process for a county is the same as a state. Try selecting a county now. (Again, we
suggest picking the county you live in.)

Note that you can change states or counties at any time during the selection process. (Of course,
if you change states, you will have to reselect a county as well!) Sense of Place doesn’t actually
look for the selected county until you press Done . You can also press Cancel at any time to cancel
the search. Go ahead and press Done when have are satisfied with your selection. (Make sure that
you have selected both a state and a county.)

When you press Done , the list window disappears, and Sense of Place looks for the position
of the selected county on the graph. Once the position is found, the indicator bar is moved there,
and the list is scrolled to show the highlighted name of the county. You can try finding several
more counties now if you like.

2.2.3 Find county on map

This item works much the way Find county on graph does. You select a county in exactly the same
way. The movable box on the state map is then moved to the position of the selected county, and
the county’s border is highlighted (shown in red instead of black) on the county map. Try finding
the county in which you live.
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2.2.4 Rank counties

The variable list appears when you select this item as it does when you select Examine variable by
county. The difference here is that you can (and should) select more than one variable. You can
pick as many as eight variables for a ranking metric. (The number of variables currently selected is
shown at the top of the list window.) Again, press Done once you are satisfied with your selections.

After you press Done , you should see the the Ranking Window, which is shown in Figure 2.5.
The Ranking Window is used to set target values for the selected variables. It is split into eight
sections, each of which may1 contain a pair of “odometers” for a selected variable. The leftmost of
the two odometers is used to set the target value for the associated variable. The odometer on the
right is used to set the importance of the variable relative to the other variables in the metric.

The target value for each variable is shown in the boxes of the odometer on the left. The
mean value is initially selected as the target value, but you can change any digit of the value by
clicking on it. To increase a digit, click on the top of its box. Click on the bottom of the box to
decrease the digit. You can also click on the min, mean, and max boxes to quickly go to these
values. Although you are limited to target values that are within the range of observed values for a
variable, this limitation is usually not constricting. The range of observed values usually includes
outliers (unusually small or large values) at both ends.

Once you have set the target value and importance for each variable, press Run Metric . Sense of
Place will then compute a score for each county based on how closely its values match the target
values. Scores are between 0 and 1000 (the lower the score the better). This takes a little time,
so a splash window appears to show the progress of the computation. When the computation is
done, the current views are redrawn to show the metric scores. The views we have seen so far are
the Graph View and the Map View. There is also a third view called the Spreadsheet View, which
will be described in Section 2.2.6.

Note that a metric score by itself does not mean much. It is mainly useful for comparative
purposes.

1The first n sections are used (starting from the top left and working first down and then to the right) for n
variables, where n is a positive integer between one and eight.

Figure 2.5: Ranking Window
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2.2.5 Show all statistics for a county

This item allows you to look at all data for a selected county. The selection process is the same as
that used for Find county on graph and Find county on map. When you press Done after selecting
a county, the variable list is shown with the values for that county. Section 2.2.1 describes how to
select variables from this list.

2.2.6 The Spreadsheet View

So far, we have looked at two views: the Map View and the Graph View. We have also looked at
the Ranking Window, which can also be considered a view, since it shows the ranges and mean
values for the metric variables. We will now look at the fourth and final Sense of Place view: the
Spreadsheet View. We will also look at how you can switch back and forth between views.

We are introducing the Spreadsheet View last because it is the last one to become available
when you run the program. It is used to show the details of ranking metric scores, so you cannot
access it until you run a metric.

The Spreadsheet View contains a scrollable spread sheet which lists all counties one to a line.
Each line contains the name of a county, its metric score, and the county’s values for all the
variables in the metric. The Spreadsheet View is shown in Figure 2.6. County names and ranks (in
parentheses) are shown in the leftmost column. Metrics scores are displayed in the second column
from the left. Values for the metric variables are shown in the remaining columns. Note that the
columns do not have headers. Since variable names are generally fairly lengthy, there is only room
enough to show one name at a time. When you aim the mouse pointer at a variable’s column, the
name of the variable name is shown above the spread sheet. The words “Metric Score” appear at
the top of the window when the pointer is in the metric score column. When the pointer is in the
county name column, the contents of the cell that it’s in are echoed above the spreadsheet.

The counties are initially listed in ascending order by metric score, but you can also sort them
by any one of the variables in the metric. Variable values are sorted by how closely they meet the
target value. To sort by a variable, click on its target value at the bottom of the Spreadsheet View

Figure 2.6: Spreadsheet View
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(the target values are aligned with the spread sheet columns). There is also a target value (always
0.00) listed for metric scores which you can click on to go back to the original sorting.

2.3 Changing Views

Since there are more views than slots in which to place them, there is a menu for selecting the
views that appear on the screen. This menu — called the “Views” menu — is shown in Figure 2.7.
To access the menu, press Views at the top of the screen.

The Views menu is accessible at any time during the program, but it’s items are inactive until
you run a ranking metric. If you haven’t run a metric yet, you might do so now, and observe how
the menu changes after you do. Each item lists a pair of views, separated by a slash (/). When
you select an item, the view to the left of the slash is placed in the top view slot, and the view to
the right is placed in the bottom.

You may notice that one of the items is still inactive in Figure 2.7. This item lists the two
views that are currently active. The item that corresponds to the currently active views will always
inactive, since it makes little sense to re-select those views.

2.3.1 Coordination of Current Views

We have tried to coordinate the interaction tools in the respective views. For example, if the Graph
View and the Map View are currently active (and show data), you can click in a county on the
county map, or on the name of a county in the list in the Graph View, and the county will be

Figure 2.7: Views menu
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highlighted in both views. In fact, you can do the same with any pairing of the Map View, the
Graph View, and the Spreadsheet View.

The one view that is not necessarily coordinated with the others is the Ranking Window. The
other three views always depict the same data. However, while you are creating a new metric with
the Ranking Window, it may be out of synch with the other views. For instance, the Spreadsheet
View may show variables and target values from a previous metric; it will not be updated to match
the Ranking Window until you run the new metric.

2.4 User Preferences

Pressing Preferences accesses a menu of attributes that you can set to suit your preference. Most
of the items on the menu belong to a pair of opposites. For example, the item State map borders:
Remove is the counterpart of the item State map borders: Add. Only one item of such a pair is
visible at any given time. For example, if the state map currently has borders on it, only State
map borders: Remove will appear on the menu. The preferences menu is shown in Figure 2.8. The
following list describes the items on the menu.

• County map magnification: Decrease. This item decreases the magnification factor2 of the
county map by one. This item is deactivated when the magnification factor reaches one.

• County map magnification: Increase. This item increases the magnification factor of the county
map by one. This item is deactivated when the magnification factor reaches eight.

• Graph curves: Discrete. This item causes the graph to be drawn as a series of discrete points.
The value for every tenth county is plotted as a point, because there is too little room to plot
values for all 3,141 counties. This item is the counterpart to Graph curves: Continuous.

2This factor expresses the relationship between the scale of the county map as it appears, and the actual scale
of the county map as stored in its image file. doesn’t express any relationship between the scales of the state and
county maps.

Figure 2.8: Views menu
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• Graph curves: Continuous. This item causes the graph to be drawn as a continuous line that
connects the values for every tenth county. This item is the counterpart to Graph curves:
Discrete.

• Map drag box: Thin lines. This item causes the movable box on the state map to be drawn
one pixel thick. This item is the counterpart to Map drag box: Thick lines.

• Map drag box: Thick lines. This item causes the movable box on the state map to be drawn
three pixels thick. This item is the counterpart to Map drag box: Thin lines.

• Map range-grading: Quantiles. This item selects rank quantile range-grading for the Map View.
This is discussed further in Section 2.4.1. This item is the counterpart of Map range-grading:
Equal intervals.

• Map range-grading: Equal intervals. This item selects equal interval range-grading for the
Map View. This is discussed further in Section 2.4.1. This item is the counterpart of Map
range-grading: Quantiles.

• State map borders: Remove. This item removes borders from the state map. This item is the
counterpart of State map borders: Add.

• State map borders: Add. This item adds borders to the state map. This item is the counterpart
of State map borders: Remove.

2.4.1 Map Range-Grading

Most of the items on the preferences menu should be fairly straight-forward. However, the range-
grading items warrant some explanation. The maps in the Map View are colored according to one
of two classification schemes. Each scheme has its pros and cons, depending on what information
you’re seeking. The first scheme is called “equal intervals”. The total range of a set values is divided
into several equal-sized intervals. Each county is colored according to the interval into which its
value falls. The important thing to note about this scheme is that it separate counties into groups
which are not generally equal in size, because the values are not generally uniformly distributed.
Because outliers increase the size of the intervals, they can greatly affect the results of this scheme.
This is good if you are looking for outliers, but not so good if you want to see subtle differences at
other parts of the range.

The other classification scheme is called “rank quantiles”. In this scheme, values are ranked
in either descending or ascending order, and the total range of ranks is divided into several equal-
sized intervals. This scheme guarantees equal-sized groups (±1), because the ranks are uniformly
distributed. This means that outliers have no affect on rank quantiles, so you can see subtle
differences at all points in the range of values. However, it also means that outliers are inapparent
under this scheme.
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2.5 Final Comments

There are two more important menus: the Help menu and the File menu. The Help menu offers
information about the program, and assistance in operating it. The File menu allows you to print
the contents of the screen to a file, or quit the program.

2.5.1 Help Menu

You can access the Help menu by pressing Help . There are two items on this menu. Sense of Place
Info accesses information on Sense of Place, including the current version of the program. Tutorial
Help accesses a text version of this manual.

2.5.2 File Menu

You can access the File menu by pressing File . There are two items on this menu. Quit causes
execution of the program to terminate. Save Screen allows you to save the image on the screen in
several different formats. After you select Save Screen, a dialog box will appear with buttons for
changing the file format, saving the screen, or cancelling the operation. When you press Save , you
should see a white line run down each side of the screen. When the save operation is finished, a
window will appear with the name of the output file on it. Press Done in this window to continue
with the program.


